Questions & Answers
Had enough of recurrent warning messages and superfluous dialogs?
David Moss shows you how to get rid of these irritations and more.

Enough already

O

Disk Cleanup I Mae 0

now have two entries in the Components

Set**

message in Windows 98 that tells me

I'm running low on disk space? I know
I am, but I don't need constant reminders.
W Klee
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In the Have Disk dialog you'll see that you

go Disk Cleanup lar fr )

Is it possible to get rid of the warning

window. Select the second item in the list,
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17 lila-Five
- iunt1074 t7irscrpianabdi47tri-titiq
Doan*

Yes, this is quite simple to do, though

the System Policy Editor, and then click on
the Install button.
0 When it's finished, click on the OK
button to close the Add/Remove Programs
dialog.

you have to make sure you're paying

You can load the System Policy Editor in

attention to the dialog boxes at the end

two ways: either click the Start button and

of the procedure. These are the steps to take

navigate to Programs I Accessories I System

on the route to clear your irritation:
0 Head for the Start button, click on it,

Tools then select System Policy Editor from
the list, or hit Start I Run, type poledit into
the command line edit box and hit the Enter

select the Programs menu item, then
the Accessories menu item, then the
System Tools menu item and finally

key. Once it's running, follow these steps:

select Disk Cleanup.

Registry menu item.

•Go to the File menu, and select the Open

0 Select the drive you want to disable the
warning on, click on OK and then go to its
Settings tab: look for the 'If this drive runs
low in disk space, automatically run Disk

OK

Carcel

You don't regularly want to be told
you're running low on hard disk space.

Cleanup' checkbox and click in it to clear it.

•Double-click on the Local Computer icon,
then on Windows 98 Network, and finally
on Update.
•You'll see a checkbox labelled Remote
Update which you should clear by clicking
in it.

0 Click on the OK button and a dialog will
appear asking you if you're sure you want to

the network for a policy file whenever it
starts up. So why don't you get a dialog

delete files. Obviously, make sure you click

saying 'Searching for System Policy'

option from the File menu and close down

No at this point.

followed by one that says 'Loading System

the System Policy Editor.

This should ensure the warning dialog
goes away. For those wondering why you'd

Policies if a policy is actually found'? I don't
have an explanation for that, I'm afraid. You

You should now find that the dialog no
longer appears when your Windows 9x

ever want to do this, Mr Klee's example is
clear enough. He doesn't want to see the

can stop it happening if it really bothers you,
but to do so you'll need to install the System

systems start up, unless of course
there really is a System Policy that needs

dialog popping up all the time, but it's

Policy Editor, potedit.exe. To do that, follow

to be loaded.

something you'll want to disable if you've

these steps:

compressed drives, because Windows 98 will

Place your Windows 98 SE CD-ROM in

keep on telling you that the host drive is tow

your CD-ROM drive, because you'll need to

on space.

access its contents. If it autoloads, just
ignore it, close the dialog or hold down the
Shift key when you place it in the CD-ROM
drive to prevent it from autoloading in the

Odd policy
Could you please explain why people

0

always see a 'Loading System
Policies' message when they Log onto

their Windows 98 systems. I haven't set
system policies up as far as I know, and yet
this message appears every time. Have I set
the network up wrongly, or is there some
other explanation for this?

first place.

9 Go to the Start button, click on it, then
select the Settings menu option and the
Control Panel menu option.
Double-click on the Add/Remove
programs icon, then click on the Windows
Setup tab. When it's loaded, click on the Have
Disk button at the bottom of the tab page.

R Taylor

•Hit the OK button, select the Save menu

Bothered by superfluous dialogs?
Not for long.

13
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0 Click on the Browse button when the
Install From Disk dialog appears, and go to

I wondered about that message dialog

your CD-ROM drive and open the Tools folder.

every time I saw it too. You'll be
pleased to know that it's quite benign,
and is in fact the default setting for Windows

.0 Next, open the Reskit folder, then the
Netadmin folder and finally the Poledit folder.
0 Select the poledit.inf file, click OK, and

9x, which will automatically go and search

then OK again.

0

OK

Cancel
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I can't start Windows
98 at all. An error
message says that
'vmm32.vxd is required to run
Windows' and then I get
dumped to a black screen like
in the DOS days.
I Prammle

There are a number of
things you can do at
Cancel I
Save as typal
!Bch Text Farrel (MF)
this point, and which
1'
you choose will depend on
what's actually wrong with
Enclose WordPad file names and extensions in quotes
the vmm32.vxd file - this
to have them saved with the extension you desire.
could be missing or damaged,
your System folder might have gone
Not my type
missing (rare, but it could have been
How do you save a file type in
renamed as opposed to vanishing entirely),
WordPad that isn't supported in
or the PATH tine in your autoexec.bat file
its File Save As list? In Notepad I
has either been deleted or no longer points
used to just type the file name and
to the System folder.
extension, but I can't seem to get away
To find out which problem is affecting you,
with that in WordPad as it just appends
fire up your system and tet it dump you to the
whatever file format is selected in its
Command prompt, which is what it's
own choice list.
M Latimer
Fie name

Wm=

0

Save

0

you found the file in a folder named aardvark,
then for step 2 you'd type:
ren aardvark system
That should now work, though I'd
want to make double sure that <aardvark>
really was the old system folder before
doing that.
To find out if PATH is the problem,
open your autoexec.bat file in Notepad
and look to see if a PATH line is there. If it is,
but makes no reference to
c:\windows\system, then add that to the
line (with whatever directory and drive
letter substitutions are necessary).
To be honest, I can't see the latter being
your problem - more likely the file is
missing or damaged and you'll have
to do a re-install.

Move My Documents
I've recently rebuilt/configured
my machine. One of the
enhancements was to add a second
ioi xi

Registry Editor

You need to enclose the file name and
its extension in double quotes:
"filename.ext". WordPad will then
save the file with that extension, and won't
append its own extension onto the file.

0

I've uninstalled a program that's left
its entry in Add/Remove programs.
How can I get rid of the entry?
E Nail
It's an FAQ, but it does no harm to
answer it again every so often.
Removing entries that get left behind
in the Add/Remove Programs list is quite
simple, but it does involve a trip to the
Registry, so make the usual backups before
continuing with these steps:
Go to the Start button, click on it, select
the Run menu item, and type regedit into the
edit box, then hit OK.
°You then want to find the following key:

0

IIKEY_LOCAL_MACHINE \ Software \Microsoft \
Windows \CurrentVersion \Uninstall
Scroll down the list of programs under
that key in order to find the one you want,
select it in the left-hand list (check the
values that appear in the right-hand list box,
just to make sure you have the right
program) and then delete the entry.
()Close down the Registry Editor when
you've finished.
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Removing entries from the Add/Remove Programs list is easy, but make sure you have
the right one before deleting it.
currently doing (and why it reminds you of
the days of DOS). At the command prompt,
type the following:
dir vmm32.vxd /8
If that doesn't find the file, then it's
re-install time. It's not nice but at least you'll
know straight away. If it's located, make a
note of where and then rename that folder to
System by typing the following at the
Command prompt:
cd windows
ren <folder> system
(Substitute the name of your Windows
folder in step 1 if it's not called Windows. If

hard disk. Ideally, I'd like to have OS and
programs on one drive and data on
the other. The problem is that My
Documents is installed on the same
drive as Windows. I'm aware that
Windows 98 uses the notion My
Documents as a standard element of the
OS, on the Desktop, in navigation bars
and so on, and I'm assuming that just
moving the My Documents
directory/folder onto the D drive won't
be enough to update the relevant system
settings that provide that functionality.
Is there any way of installing/
Ire-(configuring the system to use a
My Documents folder from the D drive
as default, instead of the C drive?
I Bartex

Readers' Tip
Device conflicts
In Issue 39 (February 2001) I gave some
generic advice to Mr Hamam on the
subject of device conflicts within
System Manager and problems with
disconnect timings for his modem. Mr
Hamam was able to solve the problem
afflicting his system by following my
advice, and some readers emailed me
with other solutions, which are worth
displaying here. First up were Herbert
Smith and Paul King, who both had the
same advice on device conflicts. Here's
what Herbert had to say:
'I got my answer from the Seagate
FAQ page. My CD-ROM was a legacy
device from 1994, was connected to the
amplifier board and therefore not fully
detected by plug and play. To get the
device to connect, go to Control Panel I
System 1 Device Manager and doubleclick the Hard Disk Controller icon; that
reveals the icon for the PCI Bus Master
Disk Controller; double-click that icon to
give the Properties dialog, click the
Properties button; in the Properties
window, select the settings tab, go to
Dual IDE Settings which is normally set
to 'default'; change the setting to 'Both
IDE Channels enabled'; then press OK
all the way back, though it may be
necessary to reload the original CD-ROM
drivers through DOS.'
Martin Kendall wrote in with this
information on what to do if Mr Hamam's
devices were running in MS-DOS
Compatibility Mode:
'The symptoms Mr Hamam
l‘..._
reported are exactly those I had when

Indeed there is. To move the My
Documents folder, right-click on the
My Documents icon on your Active
Desktop and select its Properties menu item.
Fill in the details for the target folder or
browse to it, and then hit the OK button.
I'd recommend making a backup copy of
the contents of the My Documents folder (and
subfolders) before you make any changes it's always sensible to back up important data
before you do anything that might endanger it
in any way, and under Windows 2000 you'll
actually be prompted to move the contents of
the old folder to the new one. If you choose
not to do so, and that wasn't what you
intended, you'll find that they've all been
hidden at the old location (though they don't

0

my PC was running in MS-DOS
Compatibility Mode. This state is
reported in Control Panel I System I
Performance Tab. If this is the problem,
then the hard disk(s) are probably
reporting their size as 2GB maximum,
and there are other side effects.
Quick and dirty fix No.1: install or
enable DOS drivers for the CD-ROM. This
will only cure the CD-ROM problem, and
I can't remember if it appears in the
Control Panel System screen.
Quick and dirty fix No. 2: find out the
location of the Initiation command that
tells Windows to check for 16-bit drivers
and change it. Long-term and probably
correct solution: get latest drivers for
all devices on the PC.'
That last piece of advice should be
the starting point for everyone - always
try the latest drivers for any device. It's
so often the simplest cure, and it was
one suggested in a further email on this
topic by Eric Bowden, who also pointed
out that a check for a virus would do no
harm in this instance either.
The solution can sometimes however
lie within the Registry, and I'm indebted
to Alan Moores who wrote in pointing me
toward article Q151911 in the Microsoft
Knowledge Base, on the subject of MSDOS Compatibility Mode problems with
PCI-IDE controllers. Lastly, the system
BIOS figured in the emails on this
subject. Steve Balaam kindly wrote in
with this information:
'I also have an IBM K6-II 450 that
forgot it had both CD-RW and DVD. The

actually get deleted from there). Therefore,
under Windows 2000, if you get it wrong you'll
just have to bring up the Properties window
for the folder again and select the Restore
Default option to have My Documents move
back to where it was originally located, thus
restoring access to your files.
Windows 2000 Administrators might
be interested to know that you can use
folder redirection in Group Policies to
change where My Documents appears on a
network share, which is quite handy
because then when your users save their
files to their My Documents folder, they'll
actually be saved at a location decided by
you, ready for backup.
If you're wondering where the My

solution was not to try to add them
through Windows (it didn't work), but to
go into the BIOS (Ft on bootup) and go to
Advanced and select Load Default
Settings. When I returned to Windows,
magically the drives reappeared.
Interestingly, before I selected default
settings, both drives were correctly
listed in the BIOS.'
It just goes to show how many
possible solutions there can be to a
problem, and why technical support can
be so complicated these days. Lastly,
Herbert Smith also wrote in with regard
to Mr Hamam's modem disconnect, with
some advice about taking care on how
long those disconnect times are set for:
'The maximum setting for this is 99
minutes. Unfortunately, during
software downloads my System
decides that this is "time which may no
longer be needed", gives 3o seconds'
notice, then disconnects. The
disconnection means that the
download must be restarted, so Telstra
loves it. It seems that 99 minutes is
insufficient for many software
downloads. I'm not an intensive user,
consequently I try to run long
downloads during my ISP's cheap time,
so that I can leave the machine to look
after itself while I go to do something
more interesting. If Mr Hamam decides
to set the "disconnect" option to any
time, he should remember to
de-couple it before downloading a
software upgrade via Internet.'
Many thanks to you all for writing in.

Documents info is stored in the Registry, it
can be found at:
HKEY_CURRENT__USER \Software \Microsoft \
Windows \CurrentVersion \Explorer \Shell Folders
If you move the My Documents folder
somewhere else on your system, the change
is recorded at that entry, but a new entry is
created at the following location:
HKEY_CURRENT_USER \Software \Microsoft \
Windows \CurrentVersion \Explorer \User
Shell Folders
That's important to know because if the
redirection and change to My Documents
www.pcauthority.com.au
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Call me a CAB

Readers' Tip 2

ci

Unresponsive MSGSRV32
information - I kicked myself because
I'd forgotten that this had actually

'I run Windows 98 SE, and every
time I restart my machine it stops

happened to me on a couple of
occasions. Here's what he had to say:

system so that I can view the files again?
N Reliant

0

'The problem usually occurs when

time. When I press <Ctrl-Alt-Del> to

the user tries to access programs

check the tasks that are running, it

before all the System Tray services
have installed: the solution is to restart

always states the MSGSRV32 is not
responding. If I press the button to end
this task, everything works fine again.
I'd be very grateful if you could let me

System Tray. Next time, start in Normal
Mode and it will be okay. Just let all

suggestions for this problem, and Nick

Windows.'

You're correct in your recollections,
Mr Reliant - you should be able to view
the contents of Cabinet (Cab) files just

by double-clicking on them. If you can't,

in Safe Mode, which resets the flag
recording what's loaded into the

know what's going on.'
I gave a number of possible
Oldnall wrote in with this highly useful

them. Now, when I try to do that,

nothing at all happens. How can I restore my

In Issue 38 (January 2001) the following question was asked by M Dingle:

responding after a variable amount of

I recall being able to view the contents
of cab files just by double-clicking on

Windows 98 must have lost its fife
association for them, stolen perhaps by
another program on installation and not
restored when it was uninstalled.
Fortunately, it's easy to restore that
association by following these steps:
0 Open Windows Explorer or My Computer,

disk activity finish before using

go to the View menu and select the Folder
Options menu item.

Many thanks for that, Nick.

e Look for Cabinet in the Registered File
Types list, select it and click on Edit, and then
was carried out via a Group Policy

select the Open action and click on Edit again.
Look for an edit box labelled 'Application
Customize

Used To Perform Action' and type the

implemented by a system administrator, the
new path appears in this Registry key.
However, the option to change the location of
the My Documents folder will no longer be
available to anyone right-clicking on the My
Documents folder and selecting the
Properties menu item.

Tookars I Commands 11be:::i
ns I

following in it:

Personalized Manus and Toolbars

r Standard and Fonnattiv toolbars share one row
r Menus show recently used oemmands first

explorer.exe /root,{0CD7A5C0-9F37-110E-AE6508002B2E1262},%1

ahe: a :0-dst Slav
Reset my usage data I

f„, Hit a lot of OK buttons to close the
dialogs, and the Cabinet file viewing should

Other

E Large KM
Pi List font names in their font

Stop indexing
How do I stop the Office index
program from running? I really don't
need it running, it always chooses the
worst moments and it just seems like a
complete waste of time to me anyway. Can I
delete it from the Start menu?
W Neighbour

®

be restored.

You don't want to just delete it from the
Start menu, as quite apart from

Show ScreenTips on [cams

r Show shortcut keys in ScreenTips
Menu animations:

Random Clipboard

j(None)

Could you explain how the Office 2000
Keyboard...)

Get your full menus back in Office 2000

Off the menu
I've just installed Office 2000 and
wish to be able to display all my
menus again.

disks that you won't be able to get space back
from. I actually think you're wrong about the

B tans

Find Fast indexer, and that once you've got rid
determined to remove it, do it in this order.
Start off by deleting all the Find Fast
index files, thus:
Click the Start and select Settings I
Control Panel. When Control Panel opens,

W Grendel

0

0

My last Office question of the month,
and a good one it is too, Mr Grendel. I

found its habit of popping up and
down disconcerting too, and determined to

gain control over this unruly beast (and to
find out why it was doing what it did). I
should point out first of alt that the Office

I must admit I found it quite disconcer-

Clipboard is actually rather useful, as unlike

ting not to be able to see all the menu

the Windows Clipboard it can hold up to 12

commands, and irritating when I

items so long as they don't exceed 4Mb in
total. In order for it to be able to store those

found I was using the little scroll- down arrows
all the time anyway, so I turned the feature

look for the Find Fast icon and double-click

off some time ago. To make your menus
display their full set of options again, go to the

on it to open it up. Look in the 'Index for

Tools menu, click on it and select the

12 items, the Office Clipboard has to be open
on your Desktop and you can turn it on by
selecting the Toolbars I Clipboard from the
View menu.

documents in and below' list and delete each

Customize menu item. Click on the Options tab

As you've noticed, when you copy, the

entry using 'Delete menu item' on the Index

when the dialog opens, and took for a checkbox
labelled 'Menus show recently used commands

Office Clipboard will suddenly pop up on the

menu. When you've done that, go back to the
Index menu and make sure that the 'Run
when I log on' checkbox is cleared, and then
click 'Close and Stop' on the Index menu.
138

fathom out what it's doing.

by checking out the Customisation area.

anything else it will leave you with a
load of index files lying around on your hard

of it you'llwant to have it back. But if you're

Clipboard works? It seems to just jump
up and down at random, and I can't

Close
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first'. Click in it to clear it and then close the
dialog. You should now have all your menu
items back.

Desktop, but in fact its appearance isn't quite
as random as it might appear:
• If you copy the same item twice in a row,
Clipboard will appear.

change it so that it reads AcbControl and hit
the Enter key.

Dave's Tip

Go back to the Edit menu, select the
Modify menu item and in the Edit DWORD

Restoring Windows 9x system files

Value dialog, click Decimal to select it, type
1 in the Value Data edit box and then hit the

There are occasions when you just
have to say to yourself, 'Damn, I need
to re-install Windows'. How long it
takes you to get to that point usually
depends on how patient you are and
the nature of the problem you're
dealing with. But if you don't fancy
sitting through the whole install
process, you might want to have a go
at just re-installing the system files
to see if that helps your case.
Obviously, that happens anyway during a full re-install, but you can use
the System File Checker tool (sfc.exe)
to just replace any altered system
files if you like. Bear in mind that
your problems may have come from a
bad program overwriting system files
that it shouldn't have done, so while

doing this may stop a program from
working, maybe it isn't a program you
want to have on your system.
To use the System File Checker tool,
simply follow these steps:
Head for the Start button, click on it,
select the Programs menu item, then
the Accessories menu item and then
the System Tools menu item.
Next click on System Information
and then select the System File
Checker menu item on the Tools menu.
()Select 'Scan For Altered Files', let it
do the scan and then have it replace any
with which it isn't happy.
I usually find that if neither of those
options (SFC or a full re-install) works,
a fresh install to a new Windows folder
is going to be needed.

OK button.
Close the Registry Editor when you've
finished. If you ever want to turn it back on
again, just change the Value Data from 1 to 0.

Reliving old sites
I greatly enjoy reading your columns
in PC Authority magazine. In the February 2001 edition (issue 39), where it
talks about finding a list of all the pages
you've ever visited on the net. How do I do
this in Windows 98? There were some pages
I found ages ago in my initial 'Gosh, wow'
frenzy on the net and I'd love to go back.
H Davies
I'd be quite surprised if there were,

®

although it's always worth a look in
your History folder, which you can

access via the History button on the toolbar,
• If you cut or copy two items consecutively in

Clipboard again. However, I've found that

by pressing the <Ctrl-H> key combination

the same Office program, it will appear.

or via the slightly convoluted menu route

• If you copy an item, paste it and then copy

even if you do that it has a tendency to return
at some point, so if you absolutely positively

another item all within the same Office
program, it will appear.

must get rid of it, then you're going to have to
get down and dirty with the Registry. As

Once you have a full12 items in it, if you
try and copy another item, a message box

usual, make all the necessary backups, then
follow these steps, after ensuring that you've

will pop up and tell you that if you continue it

closed down any running programs:

To see what that says, head for the Tools

wilt overwrite the first item that's currently in

Head for the Start button, click on it, select

menu, click on it, select the Options menu

the Office Clipboard.

the Run menu item, type regedit in the edit
box and then hit the OK button.

If you just close it each time it puts in an

View I Explorer Bar I History. If it's been
quite some time, however, you'll almost
certainly have lost those URLs, as they're
only kept in History for as long as is
specified in your Internet Explorer options.

item and have a took at the bottom frame,
labelled History.
You'll see a figure there for the number

appearance, after the third occasion you'll be
asked if you want it to stop popping up
permanently, and if you opt to do that it won't

CO Make your way to the key
HKEY_CURRENT_USER \Software\
Microsoft\Office\9.0\Common\General

of days items are kept in History. If the URLs
you wanted are gone, you might be able to

bother you again.

e You now need to create a new entry, so

find them by searching in the Files area.

To turn it back on, use View I Toolbars I
Can't get into the Cabinet? We'll soon

head for the Edit menu, select the New menu

the Settings button and then on the View

() Select the default New Value #1 and

Files button. If you have a lot of items in
there, it will take some time to load. In

sort your access.
Foldet Options

Germal I View

The Office Clipboard loaded up and

Fie Type: I

ready to rock 'n' roll.

SAiidoed Nom,

Clipboard (12 of 12)

Adobe Acrobat Document
aemove

%Advanced Streaming Format File
%Advanced Streaming Redirect°, Fie
VAIFF Format Sound
Animated Cursor
MAppication
ART Image

s&.

I

there you'll find hundreds, indeed
thousands, of entries for all the items
you've seen on Web pages as you've
browsed them. You might find a search

Hew Type.. I
Adobe Acrobat Forms Document
l

Go to the frame above History, click on

item and then DWORD Value.

through there to be fruitful, albeit
somewhat long-winded, even given the
sorting capabilities available.

e

David Moss

File type details
Extension;
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Content Type (MIMEt.
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